
Συμβολικές Γλώσσες Προγραμματισμού 

Ενότητα 3: Αριθμητικοί υπολογισμοί  

Νικόλαος Καραμπετάκης 
Τμήμα Μαθηματικών



Άδειες Χρήσης
è Το παρόν εκπαιδευτικό υλικό υπόκειται σε άδειες χρήσης Creative Commons. 
è Για εκπαιδευτικό υλικό, όπως εικόνες, που υπόκειται σε άλλου τύπου άδειας 
χρήσης, η άδεια χρήσης αναφέρεται ρητώς. 
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Χρηματοδότηση
è Το παρόν εκπαιδευτικό υλικό έχει αναπτυχθεί στα πλαίσια του εκπαιδευτικού έργου του 
διδάσκοντα.

è Το έργο «Ανοικτά Ακαδημαϊκά Μαθήματα στο Αριστοτέλειο Πανεπιστήμιο Θεσσαλονίκης» 
έχει χρηματοδοτήσει μόνο την αναδιαμόρφωση του εκπαιδευτικού υλικού. 

è Το έργο υλοποιείται στο πλαίσιο του Επιχειρησιακού Προγράμματος «Εκπαίδευση και Δια 
Βίου Μάθηση» και συγχρηματοδοτείται από την Ευρωπαϊκή Ένωση (Ευρωπαϊκό Κοινωνικό 
Ταμείο) και από εθνικούς πόρους.
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Περιεχόμενα
1. Αριθμητικοί τελεστές.
2. Προσεγγιστικοί υπολογισμοί.
3. Τελεστές Σύγκρισης.
4. Λογικοί Τελεστές.
5. Γνωστές συναρτήσεις.
6. Σταθερές.
7. Ανάθεση τιμής σε μεταβλητή.
8. Τύποι αριθμών.
9. Βοήθεια.

10. Αριθμητικό άθροισμα και γινόμενο αριθμών.
11. Εύρεση λύσης εξίσωσης.
12. Αριθμητική βελτιστοποίηση.
13.  Ορισμένα Ολοκληρώματα.
14. Τυχαίοι αριθμοί.
15. Θεωρία αριθμών.
16. Αποθήκευση και έξοδος.
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Σκοποί Ενότητας
è Μελέτη των αριθμητικών υπολογισμών που πραγματοποιούνται με το 
Mathematica.
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Αριθμητικοί Τελεστές (1)
Ðñüóèåóç (+)

3 + 4

7

Áöáßñåóç (-)

123 - 321

198

Ðïëëáðëáóéáóìüò

78 * 84

6552
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Αριθμητικοί Τελεστές (2)
Äéáßñåóç

35 24

35
24

Äýíáìç

2^24

16777216
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Αριθμητικοί Τελεστές (3)
ÐñïóðÜèçóå íá õðïëïãßóåéò ôéò ðáñáêÜôù åêöñÜóåéò :

31¥
4

23
- 52

32 + 24 - 23 + 22

2 - 34

31 *4 23 - 52

-
1072

23

32 + 24 - 23 + 22  2 - 34
517

16
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Τελεστές Σύγκρισης (1)
Éóüôçôá (== Þ Equal[x,y])

5 ä 5

True

ÄéÜöïñï (!= Þ Unequal[x,y])

5 π 6

True
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Τελεστές Σύγκρισης (2)
Ìåãáëýôåñï (> Þ Greater[x,y]), Ìåãáëýôåñï Þ ßóï (>= Þ GreaterEqual[x,y])

5 ≥ 3

True

Ìéêñüôåñï (< Þ Less[x,y]), Ìéêñüôåñï Þ ßóï (<= Þ LessEqual[x,y])

7 < 9

True
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Λογικοί Τελεστές (1)
¼÷é (! Þ Not[x])

Not3 >= 3

False

Êáé (&& Þ And[x,y])

4 ä 3 && 3 > 2

False

And4 ä 3, 3 > 2

False
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Λογικοί Τελεστές (2)
¹ (|| Þ Or[x,y])

True  True

True

Þ/êáé (&&! Þ Xor[x,y])

3 > 4 && ! 3 < 5

False

Ç óåéñÜ ðñïôåñáéüôçôáò åßíáé Not, And, Or.

ÐñïóðÜèçóå íá õðïëïãßóåéò ôï áðïôÝëåóìá ôçò Ýêöñáóçò

(1<2) êáé ü÷é (4<2)
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Ανάθεση τιμής σε μεταβλητή (1)
ÌåôáâëçôÞ=Ýêöñáóç

c = 1

1

c = c+ 1

2

c++

2

c

3

++c

4
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Ανάθεση τιμής σε μεταβλητή (2)

c

4

c--

4

c

3

--c

2

c

2
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Ανάθεση τιμής σε δύο μεταβλητές
ÁíÜèåóç ìéáò ôéìÞò óå äýï ìåôáâëçôÝò x=y=ôéìÞ

x = y = 1

1

x

1

y

1
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Διαγραφή των τιμών μιας μεταβλητής
ÄéáãñáöÞ ôùí ôéìþí ìéáò ìåôáâëçôÞò (Clear[ìåôáâëçôÞ] Þ ìåôáâëçôÞ=.)

Clearx, y, c

c

c
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Ανάθεση τιμής σε μεταβλητή (3)
Áí  ìåôÜ  áðü  ìéá  åíôïëÞ  áêïëïõèåß  åñùôçìáôéêü,  äåí  åìöáíßæåôáé  ôï
áðïôÝëåóìá ôçò åêôÝëåóçò ôçò åíôïëÞò (÷ñÞóéìï óôá ðñïãñÜììáôá).

x = 1; y = 1

1

** Åßíáé öñüíéìï íá ÷ñçóéìïðïéïýìå ïíüìáôá ìåôáâëçôþí ðïõ áñ÷ßæïõí ìå
ìéêñü ãñÜììá ãéá íá ôá îå÷ùñßæïõìå áðü ôéò óõíáñôÞóåéò.
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Σταθερές (1)
ð (Pi)

NPi, 5

3.1416

e (E)

NE, 5

2.7183

ð/180 (áêôßíéï) (Degree)

NDegree, 5

0.017453
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Σταθερές (2)

i= -1 (I)

3 + 4 * I * 4 - 5 * I

32 + Â

¢ðåéñï (Infinity)

ArcTanInfinity
π
2

Õðïëïãßóôå ôéò åêöñÜóåéò

1 - i 1 + i

tan-1
1

ð
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Ακέραιοι και Ρητοί αριθμοί (1)

3 4

3
4

FullForm%

Rational3, 4
Ï ðáñáðÜíù áñéèìüò åßíáé ñçôüò üðùò öáßíåôáé ðáñáêÜôù

Head%

Rational
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Ακέραιοι και Ρητοί αριθμοί (2)
Óå áíôßèåóç ìå Üëëåò ãëþóóåò ðñïãñáììáôéóìïý, óôï Mathematica áêÝñáéïé
êáé ñçôïß áðïèçêåýïíôáé óôçí ðëÞñç ìïñöÞ ôïõò.

Precision%%



Ãéá ðñÜîåéò ìåôáîý áêåñáßùí ðïõ ìðïñåß íá ÷åéñéóôåß ï Ç/Õ ÷ñçóéìïðïéåß ôéò
äõíáôüôçôåò ôïõ Ç/Õ

2^3 + 2^5

40

äéáöïñåôéêÜ ÷ñçóéìïðïéåß åéäéêïýò áëãïñßèìïõò

2^256 + 2^1024

179 769 313 486 231 590 772 930 519 078902 473 361 797 697 894 230 657 273 430081 157 732 675 805 500 963 132 708 477 322 407 536 021 120 113 879871 393 357 
658 789 768 814 416 622 492 847 430 639 474124 377 767 893 424 865 485 276 302 219 601246 094 119 453 082 952 085 005 768 838150 682 342 462 881 589 705 199 
778 143 432 586 921 495 693 274 206 093 217230 604 120 280 344 292 940 337 537 353 777152
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Ακέραιοι και Ρητοί αριθμοί (3)
ÕðÜñ÷åé óõíÜñôçóç ðïõ åëÝã÷åé áí Ýíáò áñéèìüò åßíáé áêÝñáéïò Þ áí Ýíá
áðïôÝëåóìá áðïôåëåß áñéèìü.

IntegerQ%

True

NumberQ%%

True

Ôï ìÝãåèïò óå byte ðïõ êáôáëáìâÜíåé ï ðáñáðÜíù áñéèìüò åßíáé

ByteCount%%%

184
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Ακέραιοι και Ρητοί αριθμοί (4)

Head1.4142

Real

Precision1.4142

MachinePrecision

Ôï ð äåí åßíáé áñéèìüò

HeadPi, NumberQPi

Symbol, False
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Μιγαδικοί αριθμοί (1)
¸óôù ï ìéãáäéêüò áñéèìüò

z = 3 + 2 I

3+ 2 Â

FullFormz

Complex3, 2

Ôï ðñáãìáôéêü ôïõ ìÝñïò åßíáé

Rez

3

åíþ ôï öáíôáóôéêü ôïõ ìÝñïò

Imz

2
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Μιγαδικοί αριθμοί (2)
Ï óõæõãÞò ôïõ z åßíáé

Conjugatez

3  2 

Ôï ìÝôñï ôïõ z åßíáé

Absz

13

åíþ ôï üñéóìá ôïõ åßíáé

Argz

ArcTan 2
3
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Μιγαδικοί αριθμοί (3)
ÔñéãùíïìåôñéêÞ ìïñöÞ áñéèìïý

x = - 3 + I

Â - 3

Absx

2

Argx
5 �

6
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Μιγαδικοί αριθμοί (4)
Ç ôñéãùíïìåôñéêÞ ìïñöÞ ôïõ ìéãáäéêïý x åßíáé

Simplify2* Cos
5 Pi

6
+ I Sin

5 Pi

6
 

  3

ÍéïóôÝò ñßæåò ôçò ìïíÜäáò (óõìðåñéëáìâáíïìÝíùí êáé ìéãáäéêþí).

Clearz
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Μιγαδικοί αριθμοί (5)

Solvez^4ä 1, z

zØ-1, zØ-Â, zØÂ, zØ 1
Þ êáé áñéèìçôéêÜ

Solvez^4 == 1, z  N

z  1., z  0.  1. , z  0.  1. , z  1.
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Άσκηση 1
ÁóêÞóåéò. Íá õðïëïãßóåôå ôéò ðáñáóôÜóåéò

É+ É2+ É3+ É4

1

z2- z
áí z =

1- i 3

2

a+ bi10+ b- ai10

Íá êÜíåôå ÷ñÞóç ôçò óõíÜñôçóçò Simplify[ ] ðïõ Ý÷åé ùò óêïðü ôçí áðëïðïßçóç åêöñÜóåùí. 
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 Προσεγγιστικοί Υπολογισμοί (1)
Ïé ðñÜîåéò ìåôáîý áêåñáßùí ìáò ïäçãåß óå áêÝñáéï Þ ñçôü áðïôÝëåóìá. Áí
èÝëïõìå  íá  õðïëïãßóïõìå  üìùò  ôï  áðïôÝëåóìá  ùò  ðñáãìáôéêü  áñéèìü  èá
ðñÝðåé íá êÜíïõìå ÷ñÞóç ôçò óõíÜñôçóçò Í (ìå äýï ôñüðïõò).

N1  3

0.333333

1  3  N

0.333333

Ìðïñïýìå  áí  èÝëïõìå  íá  ïñßóïõìå  ôçí  áêñßâåéá  ôùí  õðïëïãéóìþí  ìáò
äçëþíïíôáò ôï  ðëÞèïò n  ôùí óçìáíôéêþí øçößùí ðïõ  èÝëïõìå íá  Ý÷åé  ç
Ýêöñáóç ìáò expr N[expr,n]. 

NPi, 6

3.14159
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 Προσεγγιστικοί Υπολογισμοί (2)

NPi, 100
3.141592653589793238462643383279502884197169399375105820974944592307816406286208998628034825342
117068

Ìðïñïýìå íá õðïëïãßóïõìå ôçí áêñßâåéá ðïõ ÷ñçóéìïðïéåß ôï Mathematica
ãéá õðïëïãéóìïýò ðïõ êÜíåé.

N17^1 2

4.12311

Precision%

MachinePrecision
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 Προσεγγιστικοί Υπολογισμοί (3)
Åýêïëá  ìðïñïýìå  íá  ìåôáôñÝøïõìå  ìéá  ðñáãìáôéêÞ  Ýêöñáóç  Ýêöñáóç  óå
áêÝñáéá

Rationalize%%, 0
76996132
18674305

Íá õðïëïãßóåôå ôçí ðáñáêÜôù Ýêöñáóç ìå áêñßâåéá 20 óçìáíôéêþí øçößùí

êáé óôç óõíÝ÷åéá íá ôçí ìåôáôñÝøåôå óå ñçôü áñéèìü 2 .
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Γνωστές συναρτήσεις (1)
ÔñéãùíïìåôñéêÝò  óõíáñôÞóåéò  (Sin[x],  Cos[x],  Tan[x],  ArcSin[x],  ArcCos[x],
ArcTan[x])

SinPi 2

1

ArcTanInfinity
π
2

ÅêèåôéêÞ (Exp[x]), ËïãÜñéèìïò ìå âÜóç ôï b (Log[b,x], ìå âÜóç ôï e Log[x]) 

LogE

1

Συμβολικές Γλώσσες Προγραμματισμού 33



Γνωστές συναρτήσεις (2)

ExpLogx

  3

Áðüëõôç ôéìÞ ôïõ x (Abs[x]), Ðñüóçìï ôïõ x (Sign[x])

Abs-3

3

Ðáñáãïíôéêü  (!),  Õðüëïéðï  ôçò  äéáßñåóçò  ôïõ  n  ìå  ôï  m  (Mod[n,m]),  ï
ðëçóéÝóôåñïò áêÝñáéïò óôïí x (Round[x])

45 !

119622220865480194561963161495657715064383733760 
000000000
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Γνωστές συναρτήσεις (3)

Mod10, 3

1

Round4.56

5

Round-4.56

5

Õðïëïãßóôå ôéò åêöñÜóåéò

çì ð 42 + óõí ð 42
eð - ðe
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Βοήθεια (1)
ÂïÞèåéá ãéá ôçí óýíôáîç ôçò åíôïëÞò Plot.

? Plot
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Βοήθεια (2)
ÅðéðëÝïí ðáñÜìåôñïé ôçò óýíôáîçò ôçò åíôïëÞò ôçò Plot.

?? Plot
AttributesPlot  HoldAll, Protected

OptionsPlot  AlignmentPoint  Center, AspectRatio  1
GoldenRatio

, Axes  True, AxesLabel  None,

AxesOrigin  Automatic, AxesStyle  , Background  None, BaselinePosition  Automatic, BaseStyle  ,
ClippingStyle  None, ColorFunction  Automatic, ColorFunctionScaling  True, ColorOutput  Automatic,
ContentSelectable  Automatic, CoordinatesToolOptions  Automatic, DisplayFunction  $DisplayFunction, Epilog  ,
Evaluated  System`Private`$Evaluated, EvaluationMonitor  None, Exclusions  Automatic, ExclusionsStyle  None,
Filling  None, FillingStyle  Automatic, FormatType  TraditionalForm, Frame  False, FrameLabel  None,
FrameStyle  , FrameTicks  Automatic, FrameTicksStyle  , GridLines  None, GridLinesStyle  , ImageMargins  0.,
ImagePadding  All, ImageSize  Automatic, ImageSizeRaw  Automatic, LabelStyle  , MaxRecursion  Automatic, Mesh  None,
MeshFunctions  1 &, MeshShading  None, MeshStyle  Automatic, Method  Automatic, PerformanceGoal  $PerformanceGoal,
PlotLabel  None, PlotPoints  Automatic, PlotRange  Full, Automatic, PlotRangeClipping  True,
PlotRangePadding  Automatic, PlotRegion  Automatic, PlotStyle  Automatic, PreserveImageOptions  Automatic, Prolog  ,
RegionFunction  True &, RotateLabel  True, Ticks  Automatic, TicksStyle  , WorkingPrecision  MachinePrecision
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Βοήθεια (3)
ÅíôïëÝò ðïõ ôåëåéþíïõí óå Q.

? *Q
System`

AcyclicGraphQ
CompleteGra-
phQ

DiscreteTime-
ModelQ

ExactNumber-
Q ImageQ

IsomorphicGr-
aphQ

MachineNum-
berQ NumericQ

PermutationC-
yclesQ

QuadraticIrrati-
onalQ StringQ UnsameQ

AlgebraicInte-
gerQ

ConnectedGr-
aphQ

DistributionPa-
rameterQ FileExistsQ

IndependentE-
dgeSetQ LegendreQ MarcumQ

ObservableM-
odelQ

PermutationLi-
stQ RootOfUnityQ

SymmetricMa-
trixQ UpperCaseQ

AlgebraicUnit-
Q

ContinuousTi-
meModelQ EdgeCoverQ FreeQ

IndependentV-
ertexSetQ LetterQ

MatchLocalN-
ameQ OddQ PolynomialQ SameQ SyntaxQ ValueQ

ArgumentCou-
ntQ

ControllableM-
odelQ EdgeQ GraphQ

InexactNumb-
erQ

LinkConnecte-
dQ MatchQ OptionQ

PositiveDefinit-
eMatrixQ SatisfiableQ TautologyQ VectorQ

ArrayQ CoprimeQ EllipticNomeQ
GroupElemen-
tQ IntegerQ LinkReadyQ MatrixQ OrderedQ PossibleZeroQ SimpleGraphQ TensorQ VertexCoverQ

AtomQ DigitQ EmptyGraphQ
HamiltonianG-
raphQ

IntervalMemb-
erQ ListQ MemberQ

OutputControl-
lableModel-
Q PrimePowerQ SquareFreeQ TreeGraphQ VertexQ

BinaryImageQ
DirectedGrap-
hQ

EulerianGrap-
hQ

HermitianMatr-
ixQ

InverseElliptic-
NomeQ

LoopFreeGra-
phQ NameQ PartitionsQ PrimeQ StringFreeQ TrueQ

WeightedGra-
phQ

BipartiteGrap-
hQ DirectoryQ EvenQ

Hypergeometr-
icPFQ

IrreduciblePol-
ynomialQ LowerCaseQ NumberQ PathGraphQ

QHypergeom-
etricPFQ StringMatchQ

UndirectedGr-
aphQ

PacletManager`
PacletNewerQ

¢ëëïò ôñüðïò : Help -> Help Browser

Ðùò óõíôÜóóåôáé ç implicitplot ;
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Αριθμητικό άθροισμα (σειρές) (1)
Ôï  Üèñïéóìá  ôùí  üñùí  ìéáò  áêïëïõèßáò  õðïëïãßæåôáé  ìå  ôçí  óõíÜñôçóç
Sum[Ýêöñáóç,{ìåôáâëçôÞ,áñ÷éêÞ ôéìÞ, ôåëéêÞ ôéìÞ, [,âÞìá]}] áëëÜ êáé NSum
ãéá áñéèìçôéêïýò õðïëïãéóìïýò.

Sum1  i, i, 1, Infinity


i1

 1
i

NSum1  i, i, 1, 100

5.18738

Sum1  i^2, i, 1, Infinity

π2

6
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Αριθμητικό άθροισμα (σειρές) (2)

NSum1  i^2, i, 1, Infinity

1.64493

Sum1  i^2, i, 1, Infinity, 2

π2

8

Sumi^2, i, 1, k
1
6
k 1  k 1  2 k
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Αριθμητικό άθροισμα (σειρές) (3)

¢óêçóç. Äåßîôå üôé ôï Üèñïéóìá 
i=1

n

i 3åßíáé ôÝëåéï ôåôñÜãùíï.

Ìðïñïýìå íá õðïëïãßóïõìå êáé äéðëÜ áèñïßóìáôá üðùò

Sum1  i + j, i, 1, 50, j, 1, 50

4532255594555881486679280170 968012322314159 
69720375229712477164533808935312303556800

N%

65.0062
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Γινόμενα αριθμών 
¼ôáí èÝëïõìå íá õðïëïãßóïõìå ãéíüìåíá áñéèìþí ÷ñçóéìïðïéïýìå ôçí óõíÜñôçóç Produc-
t[Ýêöñáóç,{ìåôáâëçôÞ,áñ÷éêÞ ôéìÞ, ôåëéêÞ ôéìÞ [,âÞìá]}] åíþ ãéá áñéèìçôéêïýò õðïëïãéóìïýò
ôçí NProduct

Producti, i, 1, 50

30414093201713378043612608166064768844377641568960512000000000 
000

NProducti, i, 1, 50

3.04141  1064

Producti  1+ j, i, 1, 10, j, 1, 10

1
25937424601

N%

3.85543  1011
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Εύρεση λύσης εξίσωσης (1)
Ìðïñïýìå íá ëýóïõìå áëãåâñéêÜ ìéá åîßóùóç ìå ôçí âïÞèåéá ôçò NSolve

Clearx

NSolvex^2 - 5 *x + 6 ä 0, x

x  2., x  3.
Áí üìùò ç åîßóùóç äåí ìðïñåß íá ëõèåß áëãåâñéêÜ üðùò ç ðáñáêÜôù

NSolvex^3 *Expx - Sinx ä 0, x

NSolvex x3  Sinx  0, x

ôüôå  ìðïñïýìå  íá  ÷ñçóéìïðïéÞóïõìå  ôçí  FindRoot  äßíïíôáò  ìéá  áñ÷éêÞ
ðñïóÝããéóç ãéá ôçí åðßëõóç ôçò ð.÷. (ðñïóÝããéóç 1)
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Εύρεση λύσης εξίσωσης (2)

FindRootx^3 *Expx - Sinx ä 0, x, 1

x  0.683126
Ç åðéëïãÞ  ôçò  áñ÷éêÞò  ðñïóÝããéóçò  ìðïñåß  íá  ãßíåé  ìå  ôçí  âïÞèåéá  ôçò
ãñáöéêÞò ðáñÜóôáóçò ôçò óõíÜñôçóçò

Plotx^3 *Expx - Sinx, x, -4, 2

-4 -3 -2 -1 1 2

-2

-1

1

2

3

4
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Εύρεση λύσης εξίσωσης (3)
Ìðïñïýìå íá ëýóïõìå êáé óýóôçìá åîéóþóåùí ìå ôéò ßäéåò óõíáñôÞóåéò áñêåß
íá êëåßóïõìå ôéò åîéóþóåéò êáé ôéò Üãíùóôåò ìåôáâëçôÝò óå áãêßëåò

NSolvex^2 + y^2 == 1, y == x, x, y

NSolve1  x2  1, 1  x, x, 1

FindRootx2 + y2 == 1, y == x Expx, x, .1, y, .5

x  0.513489, 1  0.858096
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Εύρεση λύσης εξίσωσης (4)

<< Graphics`ImplicitPlot`

ImplicitPlotx^2 + y^2 ä 1, y ä x *Expx, x, -5, 5, y, -5, 5

ImplicitPlot1  x2  1, 1  x x, x, 5, 5, 1, 5, 5

FindRootx2 + y2 == 1, y == x Expx, x, -1.5, y, -0.5

x  0.930244, 1  0.366942
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Άσκηση 2
Õðïëïãßóôå ôçí ëýóç ôïõ óõóôÞìáôïò

3 x + 4 y + 5 z = 1

4 x + 5 y + 3 z = 2

5 x + 3 y + 4 z = 3
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Αριθμητική βελτιστοποίηση (1)
Ìå  ôçí  óõíÜñôçóç  FindMinimum  ìðïñïýìå  íá  õðïëïãßóïõìå  ôï  ôïðéêü
åëÜ÷éóôï  ìéáò  óõíÜñôçóçò,  äßíïíôáò  ìéá  áñ÷éêÞ  ðñïóÝããéóç  ôïõ  ôïðéêïý
åëÜ÷éóôïõ

Plotx^3 *Expx - Sinx, x, -4, 2

-4 -3 -2 -1 1 2

-2

-1

1

2

3

4

Συμβολικές Γλώσσες Προγραμματισμού 48



Αριθμητική βελτιστοποίηση (2)
Ôïðéêü åëÜ÷éóôï

FindMinimumx^3 *Expx - Sinx, x, 0

0.295004, x  0.419145
¢ëëï ôïðéêü åëÜ÷éóôï

FindMinimumx^3 *Expx - Sinx, x, -2

1.99776, x  4.37473
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Αριθμητική βελτιστοποίηση (3)
Ìðïñïýìå íá õðïëïãßóïõìå ôïðéêü åëÜ÷éóôï óõíáñôÞóåùí ìå ðåñéóóüôåñåò
áðü ìéá ìåôáâëçôÝò

FindMinimumx^2 + y^2, x, 0, y, 0

0., x  0., 1  0.

Plot3Dx^2 + y^2, x, -3, 3, y, -3, 3
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Αριθμητική βελτιστοποίηση (4)
Ìðïñïýìå íá õðïëïãßóïõìå ôï åëÜ÷éóôï ìéáò óõíÜñôçóçò ðïõ õðüêåéôáé óå
êÜðïéïõò ðåñéïñéóìïýò

ConstrainedMinx - y - z, y + z < 3, x > 7, x, y, z

ConstrainedMin1  x  z, 1  z  3, x  7, x, 1, z
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Ορισμένα Ολοκληρώματα
Ç  óõíÜñôçóç  NIntegrate[expr,{x,xmin,xmax}]  õðïëïãßæåé  ôï  ïñéóìÝíï
ïëïêëÞñùìá óôï ðåäßï ïñéóìïý [xmin,xmax]

NIntegrate1  x^2 + 1, x, -1, 1

1.5708

Plot1  x^2 + 1, x, -5, 5

-4 -2 2 4

0.2

0.4

0.6

0.8

1.0
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Τυχαίοι αριθμοί (1)
Äçìéïõñãßá ôõ÷áßïõ áñéèìïý óôï [0,1]

Random

0.855478

Äçìéïõñãßá ôõ÷áßïõ áêÝñáéïõ áñéèìïý 0 Þ 1

RandomInteger

0

Äçìéïõñãßá ôõ÷áßïõ áêÝñáéïõ áñéèìïý óôï [0,49]

RandomInteger, 0, 49

22
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Τυχαίοι αριθμοί (2)
Ìðïñïýìå íá áëëÜîïõìå ôçí ãåííÞôñéá ôõ÷áßùí áñéèìþí ìå ôçí SeedRandom

SeedRandom1

Random

0.668693

SeedRandom1

Random

0.668693

Ôé ðáñáôçñåßôáé ðáñáðÜíù ;

Ôé íïìßæåôáé üôé êÜíïõí ïé óõíáñôÞóåéò ;
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Τυχαίοι αριθμοί (3)

RandomComplex

0.8312  0.781807 

RandomComplex, 0 + 0 * I, 10 + 10 * I

1.24634  9.34537 
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Υπόλοιπο ‐ Πηλίκο διαίρεσης
Åýñåóç ôïõ õðüëïéðïõ ôçò äéáßñåóçò ôïõ n ìå ôï m Mod[n,m]

Mod13, 4

1

Ðçëßêï ôçò äéáßñåóçò ôïõ n ìå ôï m Quotient[n,m]

Quotient13, 4

3
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Μέγιστος κοινός διαιρέτης
ÌÝãéóôïò êïéíüò äéáéñÝôçò ôùí n1,n2,... GCD[n1,n2,...]

GCD12, 15

3

Ôé ðéóôåýåôáé üôé êÜíåé ç ðáñáêÜôù óõíÜñôçóç ;

ExtendedGCD12, 15

3, 1, 1

-1 * 12 + 1 * 15

3
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Ελάχιστο κοινό πολλαπλάσιο 
ÅëÜ÷éóôï êïéíü ðïëëáðëÜóéï ôùí n1,n2,... LCM[n1,n2,...]

LCM12, 15

60

GCD12, 15 *LCM12, 15 - 12 * 15

0
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Πρώτοι παράγοντες ενός αριθμού n
Ðñþôïé ðáñÜãïíôåò ôïõ áñéèìïý n, FactorInteger[n]

FactorInteger2^12 - 1

3, 2, 5, 1, 7, 1, 13, 1
Ïé áêÝñáéïé ðïõ äéáéñïýíôáé áðü ôïí n äßíïíôáé áðü ôçí Divisors[n]

Divisors2^12 - 1

1, 3, 5, 7, 9, 13, 15, 21, 35, 39, 45, 63, 65, 91,
105, 117, 195, 273, 315, 455, 585, 819, 1365, 4095
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Πρώτοι αριθμοί 
Ï ê ðñþôïò áñéèìüò äßíåôáé áðü Prime[k]

Prime10

29

åíþ ôï ðëÞèïò ôùí ðñþôùí ðïõ åßíáé ìéêñüôåñïé ôïõ x áðü ôçí PrimePi[x]

PrimePi10

4
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Επίλυση διοφαντικής εξίσωσης (1)
¸óôù üôé èÝëïõìå ôçí ëýóç ôçò ax+by=c. Ìå ôçí âïÞèåéá ôçò ExtendedGCD ìðïñïýìå íá
õðïëïãßóïõìå : á) ôïí ìÝãéóôï êïéíü äéáéñÝôç ôùí (a,b) êáé óôç óõíÝ÷åéá íá åëÝãîïõìå áí
äéáéñåß ôï c êáé â) õðïëïãßæïõìå ôïõò áñéèìïýò x0,y0 ôÝôïéïõò þóôå a x0+b y0=MKD[a,b]. Èá
ðñÝðåé íá ðïëëáðëáóéÜóïõìå ôïõò áñéèìïýò áõôïýò ìå c/MKD[a,b].  Áò ðñïóðáèÞóïõìå íá
åðéëýóïõìå ôçí 3x+4y=6.

ExtendedGCD3, 4
1, 1, 1

IntegerQ6 ExtendedGCD3, 41
True

ExtendedGCD3, 42 *6 ExtendedGCD3, 41
6, 6
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Επίλυση διοφαντικής εξίσωσης (2)
¢ñá {-6,6}  åßíáé  ìéá ëýóç ôçò ðáñáðÜíù äéïöáíôéêÞò åîßóùóçò.  Ç ãåíéêÞ
ëýóç ôçò äéïöáíôéêÞò åîßóùóçò åßíáé {x0,y0}+{bt,-at}.

%+ 4 * t, -3 * t

6  4 t, 6  3 t
ÐñÜãìáôé

Simplify3 *%1 + 4 *%2 - 6

0
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Αποθήκευση και έξοδος
File->Save, File -> Exit
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Ασκήσεις για το σπίτι (1)
1. Íá åðéëýóåôå ôï ðáñáêÜôù óýóôçìá

x + y + az = 1

x + ay + z = a

ax + y + z = a2

2. Íá âñåßôå ôá ôïðéêÜ åëÜ÷éóôá-ìÝãéóôá ôçò óõíÜñôçóçò

x4 - 5 x3 + 3 x2 - 2 x + 1

3. Íá õðïëïãéóôåß ôï ïëïêëÞñùìá

A = 
1

• 1

t2
‚ t

êáé ôï Üèñïéóìá

B =
n=1

• 1

n2

êáé íá äåßîåôå üôé Á<Â<Á+1
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Ασκήσεις για το σπίτι (2)
4. Íá õðïëïãßóåôå 5 ôõ÷áßïõò áñéèìïýò áðü ôï 1 ùò ôï 49 êáé Ýíáí ôõ÷áßï
áñéèìü áðü ôï 1 åùò ôï 20. 

5. ÅëÝãîôå áí ï áñéèìüò

2p - 1

1  2p

üðïõ  p  ðñþôïò  áñéèìüò  ìáò  äßíåé  ðÜíôá  ðñþôï  áñéèìü  (äïêéìÜóôå  ìå
ðáñáäåßãìáôá).

6. Íá åðéëýóåôå ôçí äéïöáíôéêÞ åîßóùóç 5x+6y=12.
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Σημείωμα Αναφοράς

Copyright  Αριστοτέλειο  Πανεπιστήμιο  Θεσσαλονίκης,  Νικόλαος  Καραμπετάκης.
«Συμβολικές  Γλώσσες  Προγραμματισμού.  Ενότητα  3:  Αριθμητικοί  υπολογισμοί».
Έκδοση: 1.0. Θεσσαλονίκη 2014. 

Διαθέσιμο από τη δικτυακή διεύθυνση:

http:eclass.auth.grcoursesOCRS430
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Σημείωμα Αδειοδότησης

Το  παρόν  υλικό  διατίθεται  με  τους  όρους  της  άδειας  χρήσης  Creative  Commons
Αναφορά ‐  Παρόμοια Διανομή [1]  ή μεταγενέστερη,  Διεθνής Έκδοση. Εξαιρούνται  τα
αυτοτελή έργα τρίτων π.χ. φωτογραφίες, διαγράμματα κ.λ.π., τα οποία εμπεριέχονται
σε αυτό και τα οποία αναφέρονται  μαζί  με τους όρους χρήσης τους στο «Σημείωμα
Χρήσης Έργων Τρίτων».  

Ο δικαιούχος μπορεί να παρέχει στον αδειοδόχο ξεχωριστή άδεια να χρησιμοποιεί το
έργο για εμπορική χρήση, εφόσον αυτό του ζητηθεί.               

[1]  http:creativecommons.orglicensesbysa4.0
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Διατήρηση Σημειωμάτων

Οποιαδήποτε αναπαραγωγή ή διασκευή του υλικού θα πρέπει να συμπεριλαμβάνει:
è το Σημείωμα Αναφοράς
è το Σημείωμα Αδειοδότησης
è τη δήλωση Διατήρησης Σημειωμάτων
è το Σημείωμα Χρήσης Έργων Τρίτων (εφόσον υπάρχει)

μαζί με τους συνοδευόμενους υπερσυνδέσμους.
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